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Section 1 - Getting Started Using PC-ACE  

This guide is to be used to assist in setting up PC-ACE for Medicare A/B claim submission to 
NGS. 

Minimum System Requirements 

• SVGA monitor resolution (800 x 600) 
• Windows 8, Windows 7, Vista  
• Adobe Acrobat Reader Version 4.0 or later (for overlaid claim printing) 

 

Note: When the Windows "Large Fonts" display setting is enabled, the screen resolution 
must be 1024 x 768 or higher. The Institutional Claim Form and Professional Claim Form will 
not display properly at lower screen resolutions. 

PC-ACE Part A Full Install Instructions 

Steps 1–7 only need completing if you initiate the install from the NGS website home page. 

1. Open an Internet browser and go to https://www.NGSMedicare.com. 
2. Select Accept when presented with the Attestation page. 
3. Select your line of business and state. 
4. Select Resources at the top of the home page.  
5. Select EDI Solutions , EDI Software PC-ACE, Download PC-ACE. 
6. On the PC-ACE Download form, complete all required fields marked with an 

asterisk (*). 
7. Under Select Your Download Below, select the radio button option for PC-ACE Full 

Installation  (Institutional and Professional) PC-ACE users – Version XX 
8. Select the Submit Request button. 

• Please note the installation password NGSMAC1 at the top of the page. 
9. Once you have noted the installation password, select the Download button to 

start the download. 
10. A message will appear: ‘Do you want to open or save this file?’ Select Save. 

• Note: These instructions are designed for use with Microsoft’s Edge and 
Chrome browsers. The use of other browsers is not supported by the NGS EDI 
Help Desk. 

11. On the left side of the 'Save In' dialogue box, select the Desktop button to save the 
file to your desktop, then select Save.  

• Note: If you are using Windows 7 or 8, the buttons on the left may not be 
present. If this is the case please select Desktop from the Save in: dropdown 
box even when using MSIE.  

• Note: NGS does not support the installation of PC-ACE on a network. The file 
will begin to download to your desktop. 

12. A message will appear: 'Download complete'—close the download dialogue box 
and minimize your Internet browser in preparation for step 17. 

https://www.ngsmedicare.com/
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13. Launch the setup.zip icon; your unzip wizard should open.  

• Note: Since unzip utilities vary, you are responsible for getting this file 
unzipped to your desktop. Please follow the instructions for your unzip utility. 

14. Double Click setup.exe icon on your desktop, which will open the file. 
15. The Wise Installation Wizard will begin. 
16. Installation code is NGSMAC1. 
17. At the Welcome window, select Next. 
18. At the Drive Selection window, select Next. 
19. At the Start Installation window, select Next. 
20. Follow the online instructions until Finish is selected. 
21. To access PC-ACE, select the PCACE icon and enter the default user ID SYSADMIN 

and the password SYSADMIN. 
22. We recommend downloading additional material to assist you with PC-ACE. After 

the software successfully downloads, revisit the EDI Solutions webpage for available 
documentation. 

PC-ACE Part A Upgrade Instructions 

Please Note: Prior to performing this upgrade it is recommended that a backup of your 
current version of PC-ACE is performed. If the version of PC-ACE currently installed is more 
than two versions behind the available version with NGS, please upgrade as soon as 
possible. 

Steps 1–7 only need completing if you initiate your upgrade from the NGS website home 
page. 

1. Make sure the PC-ACE program is closed prior to doing this upgrade. 

2. Open an Internet browser and go to https://www.NGSMedicare.com. 

3. Select Accept when presented with the Attestation page. 

4. On the NGS home page, select your line of business and state. 

5. Select Resources dropdown at the top of the home page.  

6. Select EDI Solutions. 

7. Select the EDI Software Dropdown to download the software. 

8. Select Download PC-ACE. 

9. On the PC-ACE Download form, complete all required fields marked with an 
asterisk (*). 

10. Under Select Your Download Below, select the radio button option for PC-ACE 
Upgrade (Institutional and Professional) PC-ACE users Version XXXX. 

11. Select the Submit Request button. 

12. Please note the installation password NGSMAC1 at the top of the web page. 

13. Once you have noted the installation password, select the Download button to 
start the download. 

14. A message will appear: ‘Do you want to open or save this file?’ Select Save. 
Note: These instructions are designed for use with Microsoft’s EDGE and CHROME 
browser. The use of other browsers is not supported by the NGS EDI Help Desk. 

15. On the left side of the Save In dialogue box, select the Desktop button to save the 
file to your desktop, then select Save. 
o These instructions are designed for use with Microsoft’s EDGE and CHROME 

browser. The use of other browsers is not supported by the NGS EDI Help Desk. 

https://www.ngsmedicare.com/
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o On the left side of the Save In dialogue box, select the Desktop button to save 
the file to your desktop, then select Save. 

o If you are using Windows 7 or 8, the buttons on the left may not be present. If 
this is the case please select Desktop from the Save in: dropdown box even 
when using MSIE. 

o We do not support the installation of PC-ACE on a network.  

16. A message will appear: 'Download complete'—close the download dialogue box 
and minimize your Internet browser in preparation for step 17. 

17. Launch the pcaceup.zip; your unzip wizard should open. Note: Since unzip utilities 
vary, you are responsible for getting this file unzipped to your desktop. Please follow 
the instructions for your unzip utility. 

18. Double click on the pcaceup.exe icon on your desktop. 

19. The Wise Installation Wizard will begin. 

20. Installation code is NGSMAC1 (not case sensitive) and select OK. 

21. A message will appear asking if a system backup has been performed. 

a. If the answer is yes, select Yes to proceed with the update. 

b. If the answer is No, make a backup as follows: 

i. Select the No button, and then click the OK button in the Update 
Cancellation Notice window; the installation wizard will close. 

ii. Launch PC-ACE and, on the main toolbar, select the System Utilities 
button. (last button on the right) 

iii. On the Backup/Restore tab, select the Backup sub tab. 

iv. If there is a path to your normal backup folder in the Destination Drive or 
Folder field, select the Start Backup button and proceed as you normally 
do for a backup, close PC- ACE and return to step 20. 

v. If the Destination Drive or Folder field is empty, select the small button to 
the right of that field (had 3 dots on it), browse to the folder you wish to 
save your back up to and select the Open button, then select the Start 
Backup button. 

vi. In the Confirm window, select the OK button; wait while the backup 
completes. 

vii. After the backup completes, an Information window will appear stating 
that your backup has completed successfully; select the OK button. 

viii. Close PC-ACE and return to step 20. 

22. Follow the online instructions until Finish is selected. 

23. The PC-ACE Backup Reminder dialogue box will appear advising that the update 
was completed successfully. It will also recommend that you make a new backup  
now that it has been upgraded to version X.XX (you should perform this backup 
after you have confirmed that you can open a claim and/or a patient file without 
receiving an error message); select OK. 

24. To access PC-ACE, select the PCACE icon and the enter the default user ID 
SYSADMIN and the password SYSADMIN. 

25. We recommend downloading additional material to assist you with PC-ACE. After 
the software  successfully downloads, revisit the EDI Software web page for 
available documentation. 
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Logging Into PC-ACE for the First Time 

1. Upon installation of the PC-ACE software, from the Desktop click on the PC-ACE icon 
to open the software (Figure 1). 

  Figure 1 

2. Upon selecting an ICON (for example INST) the Sign On box appears. Enter 
“SYSADMIN” in the User ID and Password fields and select OK (Figure 2). 

 

 
 
 
 

 
 
Figure 2 

 

Note: NGS is unable to change, modify or reset any individual passwords once they 
have been setup in your PC-ACE software.  

Online Help Feature 

The PC-ACE program has an online help feature that can be accessed from the PC-ACE 
Claims Processing System main menu. 
 

1. Select Help, and then select Help Topics (Figure 3). 

 Figure 3 
2. Select the Index tab (Figure 4). 

a. To search for a particular subject, type a few letters of the word. 
b. Select the index entry to be reviewed, and select Display. That 

portion of the topic will appear. Review or Print the information. 
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  Figure 4 
 

Section 2 - Reference File Maintenance 

Reference File Maintenance records must be completed in order to begin utilizing the PC-
ACE Software. 
 

1. Select the Reference File Maintenance folder (yellow folder) (Figure 5). 
 

  Figure 5 
 

Patient Setup 

The Patient tab allows the addition and maintenance of patient information, including the 
patient's primary and secondary insured details. 

• The setup of the Patient’s information is optional. The patient information will not be 
accessible during claim entry or claim import if the patient database is not set up. 

• The complete patient list will be accessible during claim entry using the variable-list 
lookup feature if the patient record is set up. When a patient is selected from the 
lookup list during claim entry, all applicable patient information will auto populate 
to the appropriate claim form fields. 

• Once the patients are added, the Patient tab provides a convenient Sort By selection 
that quickly sorts the patient list by Patient PCN or Patient Name under the List Filter 
Options (Figure 6).  (Use the F1 function key for more information). 
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  Figure 6 

 
• A number of fields on the Patient/Insured Information tabs support data entry via 

fixed-list or variable-list lookups. These lookup lists are accessed by right-clicking 
the mouse in the field or pressing the F2 key in the field. 

• Helpful fly-over hints are also available for many fields by left-clicking in a field or 
hover the mouse over the field. 

1. To add a new patient record, click the New button (Figure 7). 
 

  Figure 7 
 

2. Enter the Patient Information on the following tabs (Figure 8): 
• General Information - general patient information such as the patient's name, 

address, birthdate, and various status flags. 
• Extended Info - extended patient information such as information on the 

patient's primary Provider ID. 
• Primary Insured - payer, insured, and employer information for the primary 

Institutional payer(s). 
• Secondary Insured - insured information for the secondary institutional 

payer(s). 
• Tertiary Insured - insured information for the tertiary institutional payer(s). 
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  Figure 8 
 

3. After completing data entry on the Patient Information form, click the Save button 
to save and exit the form (Figure 9). 
 
 
 
 
 
 
 
 
 
 
 
 

  
Figure 9 
 

 

4. During the patient save operation, an edit validation process is performed on all 
patient record fields. If no edit validation errors occur, no further correction is 
needed and the patient record will be saved. 
 

When edit validation errors occur, double-click the first error message to jump to the 
corresponding field.  Several Save attempts may be required when there are 
multiple errors to correct and save a "clean" patient record (Figure 10). 

  Figure 10 
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Payer Setup 

The payer information for Medicare is already present in the PC-ACE software by default. 
Add additional Payer records for other lines of business to include these payers on newly 
entered claims. 
 

1. To set up additional Payers, select the Payer tab. (Figure 11). 

2. Select New to open the payer information screen. 
 

   

 Figure 11 
 

3. Enter the new payer’s information taking advantage of the built-in lookups where 
possible by pressing the F2 key or right-clicking the mouse in the fields highlighted 
below (Figure 12). 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 12 
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4. The Payer Information window will be displayed.  Enter all the appropriate 
information in the highlighted in the following fields. 
 

Use the mouse to click into a field or press the <Tab> button to progress through the 
form. Complete the following information (Figure 13): 

 

  Figure 13 
 

Payer ID Enter the Other Payers National Identification number. 
If unknown, enter a value of choice as this is a required field 
Examples:  
9999BSCB for Blue Cross and Blue Shield 
8888AETNA for Aetna 7777MC for Medicaid 

LOB F2 or right click in this field and select the LOB for the desired 
Payer 

Full Description Enter the Company name 

Source F2 or right click in this field and select the corresponding Payer 
source 

 

5. All other fields should remain blank and select Save. 

6. Repeat the relevant steps to create additional Payer records as needed. 

7. Click Close when finished (Figure 14). 
 

 
 
 
 
 
 
 
 

 
 
Figure 14 
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Provider Record Setup for Medicare 

1. Select the Provider (Inst) tab (Figure 15). 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 15 
 

2. Select New (Figure 16). 

   Figure 16 
 

3. Enter the following information on the General Info tab: (Figure 17) 

 
 
 
 
 
 
 
 
 
 
 

 Figure 17 

 

 



 
 

13 

Field Name Action 
Provider Name Enter Provider/Facility name. 
Address Enter Provider/Facility address. 
City/St/Zip Enter Provider/Facility city, state, and ZIP code. 
Phone Enter the billing provider contact phone number. Fax Optional 

field 
Contact Enter office contact name (preferably the name of the person 

using PC-ACE). 
Provider ID/No. Enter the Provider/Facility six-digit Medicare Part A provider 

number. 
LOB Press the <F2> key or right click to show list, then and select MCA. 
Payer ID Press the <F2> key or right click to show the list, and then select 

the appropriate payer ID. 
NPI Enter the Provider/Facility NPI number. 
Tax ID/Type Enter tax identification number and E for tax ID. 
Specialty Press <F2> key to show list, then select appropriate specialty. 
Taxonomy/Type Select the appropriate taxonomy code for the facility (<F2> will 

display a list of valid taxonomy codes). 
Include in  
Lookups Type in Y 

 

4. Click on the Extended Info Tab. Press <F2> or right click in the Provider Accepts Assign 
field and select A – Assigned (Provider Accepts Medicare Assignment) (Figure 18). 

 

  Figure 18 
 

5. Select Save. 
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Submitter Setup 

1. Select the tab marked Codes/Misc. (Figure 19). 

2. Select SUBMITTER. 
 

  Figure 19 

3. The radio button defaults to Institutional.  Select View/Update with the submitter 
record highlighted (Figure 20). 

   Figure 20 
 

 General Tab 
1. Enter submitter number (e.g., NYAXXXX, HMXXXXXX, 0XXX) in the ID field (Figure 21). 
2. Enter name and address of submitter. 
3. Enter phone number, fax, contact and e-mail address. 
4. Select Save. 

 

   Figure 21 
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Referring Physician Setup (Optional) 

Referring physician National Provider Identifier (NPI) record should be created for all 
doctors ordering diagnostic tests and consultations. 

1. Select Physician on the Codes/Misc. tab (Figure 22). 

  Figure 22 

2. Select New (found on bottom left of screen) (Figure 23). 
 

   Figure 23 
 

3. Enter physician’s last name, first name, and middle initial (Figure 24). 

4. Enter physician’s NPI number. 

5. Select Save. 
 

 Figure 24 
 

6. Select Close to exit Physician Information box (Figure 25). 
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   Figure 25 

Section 3 - Claims Entry 

Upon completion of the Reference File Maintenance, claims are now ready to be manually 
entered. When importing claims from another software, the manual entry of claims may be 
bypassed.  Please follow the section on Importing Claims. 

1. Select the INST icon from the PC-ACE Claims Processing System main menu (Figure 
26). 

 

 Figure 26 
 

2. Enter SYSADMIN as both the User ID and Password in the Sign On box if it appears 
(Figure 27). 

3. Select OK. 

 
 

 
 
 
 
 

 
 

 
Figure 27 

 

4. Select Enter Claims to open the Institutional Claim Form (Figure 28). 
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   Figure 28 

Entering Claim Data 

Click on any field to enter data or press the TAB key to move from field to field left to right.  
Use the UP ARROW and DOWN ARROW keys to move up and down through the claim 
form fields, respectively. 
 

A number of productivity enhancing features are available during claim entry: 

• Claim Form Topic Help - Press the <F1> key while entering an Institutional claim and 
the software will display the Institutional Claim Form topic in PC-ACE. 

• Fixed-List Lookups – Press the <F2> key or right click in fields containing lookup 
capability to take advantage of the built in fixed-list lookup lists to select from. 

Access the lookup list for a field by positioning the cursor on the field and pressing the 
F2 function key (or right-clicking the mouse). When an item from the list is selected, its 
value is automatically entered in the claim form field.  For example, Patient Sex 
typically has 3 possible values: "M" (male), "F" (female), and "U" (unknown). 

Type "<ALT>F2" (press the <F2> key while holding the <ALT> key down) to identify all 
fields that support a lookup list. Press the <ESC> key to disable the flashing 
notification (Figure 29). 
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Figure 29 

 

• Variable-List Lookups – Applies primarily to fields whose values are selected from 
the reference files completed in Reference File Maintenance in the ‘Getting Started 
Using PC-ACE’ section above. 

 

If any information in the variable-list lookups selected from the reference files is 
incorrect and cannot be changed within the claim form, exit the Claim Form and 
make the necessary change(s) directly to the proper reference file. 
 

For example, selection of a patient from the variable-list lookup completes numerous 
patient- related fields on the claim. Access variable list lookups using the same 
method described above for fixed-list lookups. 

• Right click in the Patient Control No. field (Figure 30). 
 
 
 
 
 
 
 
 
 
 

 
Figure 30 
 

 

• Then select the patient that will be entered on the claim form (Figure 31) from the 
reference file Patient Selection to auto-populate the values from the Patient Selection 
record into the claim form (Figure 32). 
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Figure 31 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
Figure 32 

• Cancel Field Changes - When a change is inadvertently made to the contents of a 
field, press the ESC key to cancel this change and restore the field's original content. 
This feature is available for most claim form fields. 

Enter the appropriate information required for the Institutional claim form utilizing 
the mouse to click into a field or press the <TAB> button to progress through the form. 

The sections/tabs display fields in the same order as a hardcopy Institutional 
claim form (Figure 33). 
 

The Institutional claim form contains eight sections (tabs): 
• Patient Info & Codes 
• Billing Line Items 
• Payer Information 
• Diagnosis/Procedure 
• Diag/Proc (2) 
• Extended General 
• Extended General (2) 
• Extended Payer 
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                                                                                                                                                     Figure 33 
 
 

 

• Patient Info & Codes Tab 
This tab includes fields for general claim and patient information as well as the 
Condition, Occurrence, Span, and Value code fields. 

Enter the patient information manually during claim entry or while the cursor is 
displayed in Patient Control Number, press <F2> or right click to access a list of 
patients from which to select in reference file maintenance record (Figure 34). 

 

   Figure 34 
 

• Once the patient is highlighted, click on the SELECT button (Figure 35). The Patient 
Info & Codes tab will be displayed with data elements populated from the Patient 
Selection record. Press Tab or point and click to make any modifications to a form 
locator on the Patient Info & Codes tab. 
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Figure 35                                         

 
 

• If the patient is not in the Patient Selection select New (Figure 36). 
 
 
 
 
 
 
 
 
 
 
 

Figure 36 

 

• Enter in the following fields (Figure 37) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 37 
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Field Name Action 
Last Name/First Name/MI Enter patient’s name. 
Patient Control No (PCN) Enter patient control number selected by the facility. 
Address Enter patient’s address. 
City/State/Zip Enter city, state, and ZIP code. 
Phone Optional 
Sex Enter “M” for male or “F”for female or “U” for unknown. 
DOB (date of birth) Enter the date in the MM/DD/CCYY format. 

 
• Select the Extended Info tab.  Press <F2> or right click in the Primary Provider ID 

(Institutional use only) field and select the Provider record (Figure 38). 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Figure 38 
 
 

 

• Primary Insured tab if not populated (Figure 39). 

   Figure 39 

• Enter the following information: 

Field Name Action 

Payer ID Press the <F2> key or right click to show the list, and 
then select the appropriate payer for the state 
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contracted with. 
Rel (relationship to insured) Press the F2 key and enter the appropriate relationship 

to insured code Enter: 
 “18” for self 
 “01” for spouse 
 “19” for child 
Last Name/First Name/MI Enter insured’s name. 
Insured ID Enter Medicare Health Insurance Number. 
Address Enter the primary insured’s address. 
City/State/Zip Enter city, state, and ZIP code. 
Phone Optional 
Sex Enter “M” for male or “F”for female or “U” for unknown. 
DOB (date of birth) Enter the date in the MM/DD/CCYY format. 

• Select Save. 
• The Institutional Claim Form box will appear again (Figure 40). 

 
 
 
 
 
 
 
 
 

Figure 40 

 

• Billing Line Items Tab 
Enter the services/supplies rendered to the patient. Eight claim lines are displayed at 
a time on the window. The user can use the <Scroll Up> and <Scroll Down> buttons to 
move up and down within the claim (Figure 41). 

This tab also includes extended line item fields, and line-level MSP/COB fields. For 
detailed information on entering Medicare Secondary Payer claims, download the 
PC-ACE Quick Reference Guide: Medicare Secondary Payer. 
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  Figure 41 

• Line Item Scrolling - The Billing Line Items tab displays 8 claim lines at a time. For 
claims that contain more than 8 line items, the user may scroll through the claim line 
items one line at a time or one page (i.e., 8 lines) at a time using the buttons provided 
along the right edge of this tab. 

The up/down arrow keys can be utilized to move from line to line, scrolling when 
appropriate. 

Type <ALT><PAGE UP> (press the Page Up key while holding the ALT key down) or 
<ALT><PAGE DOWN> to scroll up/down through all claim line items one page at a 
time. 

• Line Item Features - The following productivity features are available on the Billing 
Line Items tab: 

• Field Duplication -- Press the F4 key while positioned on a specific field on a line to 
copy the value of that single field from the previous line into the current line 

• Line Duplication - Press the F5 key while positioned on any field on a line to copy the 
values in all fields of the previous line into the current line. 

• Line Deletion - Press the F7 key while positioned on any field on a line to delete the 
line. A prompt to confirm the deletion. Alternatively, enter the value DEL (that's an 
asterisk plus "DEL" plus another asterisk, without the double-quotes) into the HCPCS 
field on a claim line to delete the line. Make sure the field is highlighted to enter *DEL*. 

Claim lines are automatically re-sequenced by Revenue Code when a claim is saved. 
As such, there is no need to provide line rearrangement capabilities. 

• Advance To Next Line - Press the F8 key while positioned on any field on a line to 
automatically advance the cursor to the first field of the next line, skipping over any 
remaining fields on the current line. 

• Jump To Narrative - Press the <ALT>N key combination while positioned on any field 
on a line to automatically position on the "84 - Remarks" field. Enter the desired 
narrative text and press the <TAB> key to return to the original line field. 

• Line Item Totals Recalculation – The Billing Line Items tab provides a Recalculate 
button located near the bottom of the tab adjacent to the totals fields. Click this 
button to recalculate and update the Total Charges and Total Non-Covered 
Charges fields from the current claim line item charges values. Note: This button may 
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not be available on some installations. 

• Payer Info Tab 
Enter payer, provider, insured, and employer fields for the primary, secondary, and 
tertiary payers that need populating. 

• Diagnosis/Procedure 
Enter diagnosis codes, procedure codes and dates and physician information. 

• Diag/Proc (2) 
Enter additional diagnosis codes, procedure codes and dates, and claim-level 
provider information. 

• Extended General 
Enter any additional patient and general claim-level fields. 

• Extended General (2) 
Enter additional condition/occurrence/span/value codes. 

• Extended Payer 
Less frequently used payer, insured, and authorization fields for the primary, 
secondary, and tertiary payers. Also includes fields for MSP and other secondary 
claims where Coordination of Benefits (COB) information is required. This major tab 
consists of a number of second-level tabs that provide access to this extended 
information in a logical and efficient manner. 

• Click Save when finished entering the claim. 
• During the claims save operation, an edit validation process is performed on all fields. 

If no edit validation errors occur, the claim patient record is saved without further 
correction and a new Institutional claim form will appear allowing entry of another 
claim. 

• When edit validation errors occur, double-click the error message to jump to the 
corresponding field in error. Several Save attempts may be required to correct and 
save a "clean” claim. Refer to the Claim & Reference File Edit Validation topic for a 
more complete discussion of the claim edit validation process. 

• Once finished entering claims, the claims are now ready to be prepared for 
transmission (Figure 42). See Prepare Claims Function. 
Note: Use the Help Feature in PC-ACE for more information on “Listing, modifying and 
maintaining claims. 
 

Section 4 - Additional Claim Features 

Copying Claims 
Claims for the same patient can be copied and then modified instead of creating a new 
claim each time. Simply copy the previous claim, modify the dates of service and/or any 
other pertinent information, and then save it. 

1. In the Institutional Claims Menu window, select List Claims. 

2. In the Institutional Claim List window, in the bottom left section of the screen, choose 
the Location of TR – transmitted only. 

3. Put a check mark in the box in front of the claim(s) to be copied. 

4. On the Actions Menu, select Copy All Checked Claims. Select OK in the confirmation 
window. Note: If only one claim was checked to be copied, the Institutional Claim Form 
will be displayed instead of the Institutional Claim List window. 
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5. Change the dates of service and Save the claim. 

6. In the bottom section of the window, select the Location of CL – to be transmitted. 
The claims will be listed and have a status of UNP. 

7. Double-click each claim in turn, enter new dates of service, and Save. 
 

 
 
 
 
 
 
 
 
 

 
 

Figure 42 
 

Reactivating Previously Transmitted Claims and Reactivation of Individual 
Claims 

To resubmit a transmitted claim, these claims must first be reactivated. Only claims in the 
transmitted (TR) location may be reactivated. 

1. Select the Institutional icon from the PC-ACE Claims Processing System main menu 
(Figure 43). 

  Figure 43 

2. Select List Claims (Figure 44). 
 
 
 
 
 
 
 
 
 
 
 
 

 
   
  Figure 44 
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3. Select Location (Figure 45). 

4. Select CL (to be transmitted) or TR (transmitted only). 
 

   Figure 45 

5. Check one claim or several claims to be reactivated. 

6. Select Actions (Figure 46). 

7. Select either Reactivate Selected Claim (if only one claim) or Reactivate All 
Checked Claims (for more than one claim). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 46 

 

 

8. The Confirm box appears (Figure 47). 

9. Select OK to reactivate claim/claims. 
 
 
 
 
 
 
 
  Figure 47 
 

 

10. Change Location field to CL–to be transmitted (Figure 48). 
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  Figure 48 

11. Reactivated claims will be listed with a status of UNP. These must be corrected before 
sending. 

12. Either double click the claim to open and make the necessary corrections and select 
Save (Figure 49), or see the Processing Reactivated or Imported Claims section to 
Process a multitude of claims. 

 

  Figure 49 

13. The claim status will change to CLN. These claims are now ready to be prepared and 
transmitted. See Prepare Claims instructions. 

Claim Import Function 

When entering claims manually in the PC-ACE software and not importing a claims file in 
an Electronic Media Claims (EMC) format, skip this section entirely. 

For more information on the importing of UB92 Version 6.0 formats and Print Image, please 
review the HELP and enter “claim import” in search field. 

PC-ACE ANSI 837I Claim Import Capability (Importing ANSI 837I Claim Files) 
Providers can translate and import claims files in the ANSI 837I version format, for 
subsequent editing, ANSI 837 formatting and transmission. The ANSI 837I import capability 
by default is not activated in PC-ACE. 
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The Claim Import function can be utilized for MSP claims that need to be updated or 
corrected and your claims software is not capable of doing so. 

This feature should only be activated if the ANSI 837I files have already been validated as 
structurally sound and complete. It should not be used as an ANSI 837I testing validation 
tool. 

Note: Only those data elements supported in PC-ACE will be imported from the ANSI 837I 
file. Any unsupported segments and data elements present in the imported ANSI 837I file 
will be ignored. 

To activate this feature for importing ANSI 837 4010A1X12 files, perform the following: 

1. From the PC-ACE main toolbar select File, then Preferences menu items and login 
when prompted (Figure 50). 

 Figure 50 

 

2. While viewing the Preferences screen, type the ampersand (&) character (i.e., 
<SHIFT>7). An additional tab labeled System will appear. 

3. Select the System tab and check the Enable Institutional ANSI-837 claim import 
function option. 

4. Select OK to save the changes. These new settings will take effect immediately. 
(Figure 51) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 51 
 

5. Ensure all Provider records are set up prior to importing files (See instructions on 
adding/checking a provider record). 
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6. Name the claim import files with a .DAT (dot DAT) file extension and copy them into 
the C:\WINPCACE\IMPUB92 directory (Figure 52). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Figure 52 
 
 

7. On the main toolbar select the Institutional Claims Processing Menu icon (Figure 53). 

  Figure 53 

8. Select the Import Claims button (Figure 54). 
 

  Figure 54 
 

9. The Institutional Claim Import window will appear. Select Import (Figure 55). 
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Figure 55 
 

 

10. A Confirm window will be displayed. Select OK to continue (Figure 56). 
 
 
 
 

 
Figure 56 
 

 

11. When the import process is complete an Information window will be displayed to 
indicate that the operation was completed successfully. Select OK (Figure 57). 

 
 
 
 

 
Figure 57 
 
 

12. The Institutional Claim Import (EMC File) window will be displayed. The status bar 
indicates the operation is complete. The window should contain a count of imported 
and rejected claims as well as dollar amounts for each area. 

13. It is possible to print a report of imported claim information. Click on the View Results 
button to view the report (Figure 58). 

 Figure 58 
 

14. The PC-ACE Claim Import Detail Report will appear in display mode (Figure 59). 
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  Figure 59 

15. Select the printer icon to print the report or select the Close button at the top of the 
report page to exit from the report view (Figure 60). 

   Figure 60 
 

16. Select Close to return to the Institutional Claims Menu (EMC File). 

17. Once a file of claims has been imported the user can then run the Process Claims 
option and “scrub” all the claims for editing. Claims that are imported must be 
processed. 

Processing Reactivated or Imported Claims 

Claims that have been reactivated or imported need to be processed before preparing the 
claims file. Newly entered claims do not need to be processed before being prepared. 

1. On the main toolbar select the Institutional Claims Processing Menu icon (Figure 61). 
 

  Figure 61 
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2. Select the Process Claims button (Figure 62). 
 

 Figure 62 
 

3. The Automated Claim Processing window will be displayed. Fill out any fields 
desired or leave all fields blank and select the Process button (Figure 63). 

 

  Figure 63 
 

LOB: The line of business of claims to be processed 

TOB: Constrain the data to process only a certain type of bill 

Provider: Constrain the data to process only the selected provider’s claims 

Present claim with 
errors: 

Check to present claims with errors for immediate editing if the claims 
were not cleaned up while in claims list 

 

4. A Confirm window will be displayed. Select OK (Figure 64). 
 

  Figure 64 

5. When the process claims is complete an Information window will be displayed to 
indicate that the operation was completed successfully. Select the OK button (Figure 
65). 

 

 Figure 65 

6. The Automated Claim Processing window will be displayed which gives the user a 
visual of the total number of claims that were processed clean (no errors), processed 
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with errors and/or unprocessed claims (like duplicates) (Figure 66). 
 

  Figure 66 

7. Select the Close button or select the View Errors button. 

8. When the View Errors button is selected, the Adobe Acrobat will display the report, 
select the printer icon to send the report to the printer or select Close to return to the 
institutional claims list window (Figure 67). 

 

 Figure 67 

Reactivating an Entire Batch of Claims 
Changes cannot be made to a batch of claims that has been reactivated. This operation will 
restore the batch of claims so that it can be retransmitted. When changes need to be made 
to claims that have already been transmitted, see the section titled Reactivating Claims. 

1. In the Institutional Claims Menu window, select the Maintain Menu and select 
Transmission Log.  The Institutional Claims Transmission Log window will be 
displayed. 

2. Select the batch of claims to reactivate. When uncertain which batch should be 
selected, highlight the line, then select the View Details button to see Transmission 
Detail report for the batch. 

3. Once it has been determined which batch of claims to reactivate, highlight the line 
and select the 
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Reactivate button. Read each window that pops up, then select OK in each. 

4. Do not prepare the claims file when reactivating an entire batch of claims.  Simply 
transmit the claims file as normal. 

 

Section 5 - Prepare Claims Function 

Medicare claims must be prepared and transmitted using communication software before 
another batch can be prepared. Failure to follow these instructions will overwrite the 
previous claim file. When ready to prepare claims for transmission, do the following: 
 

1. Select INST from the PC-ACE Claims Processing System main menu (Figure 68). 
 

  Figure 68 
 

2. Select Prepare Claims (Figure 69). 
 
 
 
 
 
 
 
 
 
 

 
Figure 69 
 
 

3. The Institutional Claims Prepare for Transmission box appears (Figure 70). 

4. Select Prepare Claims. 
 

 Figure 70 

5. The Confirm box appears and states, “Ready to prepare selected Institutional claims 



 
 

36 

for transmission?” (Figure 71). 

6. Select OK 
 

  Figure 71 

7. The Information box appears and states, “The claim operation has completed 
successfully.” (Figure 72). 

8. Select OK. 
 

  Figure 72 

9. The Claim Prepare for Transmission box appears (Figure 73). 

10. Select View Results. 
 
 
 
 
 
 
 
 
 
 

 Figure 73 
 
 

11. PC-ACE Transmission Detail Report will appear. To print this report, select the Print 
icon (top of tool bar, to the left of the Close button). This report does not confirm the 
transmission of claims. (Figure 74) 
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 Figure 74 

12. The preparation of claims has now been completed. Prepared claims must be 
transmitted. Continue to the transmission process using the NSV’s software. 

 

Section 6 - Transmission Process 

Network Service Vendor 
All submitters should connect through a NSV and follow their connection/transmission instructions 
provided by the NSV to send and receive files. 

Note: For Part A, the claims file to be transmitted created by PC-ACE will be named TRANS.DAT by 
default and will be located in the C:\WINPCACE directory. 

Please see the list of NSVs listed on our website under the Claims & Appeals tab > Electronic Data 
Interchange Software if one has not already been selected. 

 

Transmission Reports 
Once the claim file has been sent, three reports (TRN, 999 and 277CA) will be available for 
download. 

TRN–Transaction Acknowledgement (available within a few minutes after transmission.  
Please note some network software vendors do not update or refresh right away.  The file 
may take 15 minutes or so to become available for download). 

• Look for “No input validation problems subsequent reports to follow” (Figure 75). 
Contact the NGS EDI Help Desk if any errors appear: 

o J6: 877-273-4334 
o JK: 888-379-9132 
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Figure 75 
 
999 and 277CA Reports: 

999 and 277CA files must first be imported into PC-ACE in order to view them in a 
readable format (available up to two hours following transmission). 

 

Importing and Reading the 999 and 277CA Reports 

1. Open PC-ACE and click on File then Preferences (Figure 76). 
 

  Figure 76 

2. Check the first box highlighted. To view only rejected claims in the 277CA report, check 
the second highlighted box also. To view both accepted and rejected claims in the 
277CA report, leave the second box unchecked (Figure 77). 

 

  Figure 77 
 

3. In order for PC-ACE to read 999 or 277CA files, they must be saved into the proper sub- 
folder within the WINPCACE folder (Figure 78): 
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277CA files need to be saved in the Statub92 (part A) sub-folder, of the Ansi277 folder. 
999 files need to be saved in the Ackub92 (part A) sub-folder of the Ansi997 Folder. 

 

  Figure 78 
Note: This process can be set to run from a batch command file. See Appendix A at 
the end of this document for instructions. 

4. Once the report files have been moved to the proper folder location, go to the 
Institutional Claims Menu. Select the Maintain menu item, then Acknowledgement 
File Log to read the 999 (Figure 79). 

 

 Figure 79 
 

5. The following screen will be displayed to read the 999.  From the Acknowledgement 
File Log screen, select the 999 to be displayed and select View Ack Report (Figure 80). 

See Appendix A for instructions on how to adjust the length of time archived copies 
are maintained in the system. 
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 Figure 80 

• Look for (Figure 81): 
Transaction Set Status (IK501): A - Accepted  
Functional Group Status (AK901): A - Accepted 

• If the 999 is rejected, no further editing is done and no further reports are created. 
• If the 999 is accepted or accepted with errors, a third report will be received (the 

277CA report) 
• To print the report, select the Print icon. 

 Figure 81 

6. To read the 277CA, from the Professional Claim Menu, select Maintain and Claim 
Acknowledgement Log (Figure 82). 

 
 
 
 
 
 
 
 
 

Figure 82 
 
 

 

The following screen will be displayed to read the 277CA.  From the Acknowledgement File 
Log screen, select the 277CA to be displayed and select View Ack Report (Figure 83). 
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Figure 83 
 

 

Look for Total Quantity Accepted.  Any claims that reject will need to be corrected and 
resubmitted (Figure 84): 
 
 
 
 
 
 
 
 
 
 
 
 
 

                                                                                                                  

 

                                                                                                                  Figure 84 

 
 
Scroll down to the Claim Acknowledgement for the patient information on each claim and 
it will show all the details for each claim submitted (Figure 85). 
• Claim number 
• Patient name/number 
• Provider NPI 
• HIC Number 
• ICN/DCN 
• Total charges 
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                                                                           Figure 85 

 

Appendix A: Adjusting Archived Reports Settings 

The length of time that archived copies of 999 and 277CA files are kept can be adjusted. 
From the main menu of PC-ACE, go to File, Preferences, and click the Misc tab (Figure 86). 

If desired, adjust the first two fields to indicate how long to keep the archived reports. The 
duration has been set to 1000 days in the example below. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 86 

Appendix B: Setting up Shortcuts for File Locations 

To assist in the placement of new reports shortcuts can be created (Figure 87). 
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                                                                                          Figure 87 

 

Right click on Start and then select File Explore (Figure 88). 
 
 
 
 
                                                                                                     Figure 88 

 
 
Double click on the WINPCACE folder (Figure 89). 
 
 
 
 

Figure 89 
 

 
Double click on the Ansi277 folder for a 277 shortcut. If desired, repeat this process for A 999 
shortcut in which the 997 folder should be selected (Figure 90). 
 
 
 
 
 

                  Figure 90 
 

 
Right click Statub92 folder for Part A (Figure 91). 
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Figure 91 
 

Select Send To and then Select Desktop (create shortcut) 
 

Right click on the new folder and rename the folder (i.e., 277CA Reports) with the new folder 
on the desktop, place all 277CA reports into this folder. 
 

To create a shortcut for 999 reports, repeat this process however, instead of selecting the 
ANIS277 folder select the ANSI997 folder and continue follow this process by renaming the 
folder (i.e., 999 Reports). 
 

For further assistance please send an e-mail to EDI at ngs_edi_parta@anthem.com or 
contact the EDI Help Desk: 
 
• J6: 877-273-4334 
• JK: 888-379-9132 

Appendix C: Troubleshooting 

When experiencing problems viewing 999 or 277CA reports, once saved in the correct 
subdirectory in PC-ACE, it is suggested that a system change be made. 
 
Select Start from the desktop, then go to the Control Panel select Folder Options 
Select the View tab  
 
Under Hidden Files and Folders click on the Hide extensions for known file and folders 
check box, in order to remove the selection of that option, then click on the Show hidden 
files and folders radio button to change settings (Figure 92). 
 
 
 
 
 
 
 
 
 

mailto:ngs_edi_parta@anthem.com
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                                                                                                    Figure 92 
 

This will show any hidden file(s) in the WINPCACE directory. 
 

Section 7 - How to Backup PC-ACE Claims Processing System 

Each time the program is exited the following message will appear: “Perform System 
Backup?” An external backup file of the program must be maintained in the event a fatal 
system crash occurs. 
 

1. To do this, the backup may be placed on the desktop by selecting the Browse button 
and choosing the hard drive (system C) and desktop (Figure 93 and 94). 

  Figure 93 
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  Figure 94 
 
 

2. This will put the backup file named PCACEPBK.ZIP on to the desktop (Figure 95). 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
Figure 95 
 

 

3. From the desktop, save to a CD-ROM or flash drive. This external device must be 
maintained to ensure the restore capabilities in the event of a fatal system crash. 

4. Select My Computer on the desktop and drag the PCACEPK.ZIP file from the desktop 
to the CD-ROM and then burn it, or drag to the flash drive (Figure 96). 
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Figure 96 

 

 

Section 8 - Additional Features 

Archiving Claims 
Archiving claims in PC-ACE improves performance and helps prevent database corruption. 

1. Select the Inst button on the main toolbar. 

2. Select the List Claims button. 

3. Select the File Menu and select Maintain Claim Archives 

4. Select the New button and enter a name for the archive, then select the OK button. 

5. Select the Close button. The Institutional Claim List window will be displayed. 

6. In the Claims List Filter Options section at the bottom of the Institutional Claim List 
window, select the drop down arrow and select TR-transmitted only. 

7. Select the Advanced Filter Options button near the bottom of the Institutional 
Claim List window, and enter the filter criteria. 

Example: If today’s date is 11/11/13, to archive everything except the past three 
months: 
 Check the box in front of “Invert filter logic…” at the bottom of the Advanced Claim 

List Filter Criteria window. 
 In the Transmit Date: field, enter 08/01/2013 in the first box, and then enter 

11/11/2013 in the second box. 
 Select the OK button. The Institutional Claim List window will appear and the 

only claims displayed are those that were transmitted more than three months 
ago. These are the claims that will be archived. 

1. Select the Filter Menu and select check all claims. Each claim now has a 
checkmark in the box at the left of the line it’s on. 

i. Select the File Menu and select Open Claim Archive, then, 
double-click the archive created in the steps above. An 
information window will pop up. Read the contents, then, select 
the OK button. 
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Select the Actions Menu and select Archive All Checked Claims (near 
the bottom of the Actions menu.  

ii. Be careful not to select Archive Selected Claim, as that will only 
archive the claim that is highlighted. An information window will 
pop up. Read the contents, and then select the OK button. 

2. The claims are no longer shown in the list. The claims are not gone but they 
have been stored in the archive. To see these claims, select the File menu, and 
then select View Archived Claims. 

3. Once PC-ACE has been exited, to view these claims again: 
a. Open the claims list 
b. Select the File Menu and select Open Claim Archive. 
c. Double-click the archive to view, read the information in the pop up 

Information window, and then select the OK button. 
d. Select the File Menu and select View Archived Claims. 
e. To see current claims, select the File Menu and select View Current 

Claims. 
 

Transferring PC-ACE to Another Computer 

1. On the old computer, upgrade PC-ACE to the current version. 

2. On the new computer, install the full installation of the current version from our Web 
site. 

3. On the old computer, open PC-ACE. 

4. On the main toolbar, select the last button, which has a gear and a wrench on a 
French flag. 

5. Sign in. The System Utilities window is displayed, the Backup/Restore tab should be 
selected and the Backup sub tab displays the text “This utility performs a backup…” 

6. Select the small button with three dots on it at the right end of the Destination Drive 
or Folder field. 

7. In the Select Backup Destination Directory window, select the drop down arrow at the 
right end of the “Look in” field, select Desktop which should be at the very top of the 
list, then select the Open button. The System Utilities window will be displayed. 

8. Select the Start Backup button and select the OK button in the Confirm window. 

9. After the backup operation completes, the Information window will display. If the text 
states “The backup operation has completed successfully” then select the OK button. 
Note: If the text indicates that the backup failed, please contact the NGS EDI Help 
Desk: 
J6: 877-273-4334  
JK: 888-379-9132. 

10. In the System Utilities window, select the Validate sub tab, browse to the Desktop as 
in the earlier steps, then select the Start Validate button, select the OK button in the 
Confirm window. When the validation is complete, the Information window will be 
displayed with the text “The validation operation has completed successfully:” 
Note: If the text indicates that the validation failed, please contact the NGS EDI Help 
Desk. 

11. Select the OK button in the Information window and select the Close button in the 
System Utilities window. 
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12. The backup file on the desktop is named PCACEPBK.ZIP. Copy this file to the Desktop 
of the new computer. 

13. On the new computer, open PC-ACE and on the main toolbar, select the last button, 
which has a gear and a wrench on a French flag (as directed above). 

14. Sign in. The System Utilities window is displayed, the Backup/Restore tab should be 
selected and the Backup sub tab displays the text “This utility performs a backup…” 

15. Select the Restore sub tab, browse to the Desktop, and select the Open button. It is 
not necessary to select the file because the program knows the file name already. 

16. Continue with the restore, following the prompts. Once it’s complete, PC-ACE on the 
new computer is identical to what was on the old computer. 
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